
Dreamweaver is an HTML (Hypertext Markup Language) editor that allows you to create 
HTML pages.  This program can be used to create (or edit) content to upload to a web 
directory or transfer to WebCT. 

Using HTML versus other types of documents online is simpler since people who are 
viewing your web site with a text browser or a graphical web browser do not need another 
program to open the pages as they would with a PDF, DOC, XLS and other documents. 

1. Overview of Dreamweaver 
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2. Good Practices for Web Content 

• The reason you go to a web page is to get information or content right? 
Even entertainment pages, you go there specifically to see something, to get a 
message. Remember in Web Design that this is the number one goal. 

• When you design your page, you want to have the most colorful page, with the coolest 
  graphics and animation, right? 

You want to show your personality. Great! But, you have to think about the main goal 
of a web site is to communicate a message. 

Remember the following when creating your content for the web. 
• Your site must be accessible. 
• Keep it simple 
• 50% of your page to be Useable content - Usable content is defined as what the visitor 

came there for: Entertainment, Information, Examples, etc... 
• 20% of your site to be Navigation - A Logical Navigation is crucial to getting your message 

across: How easy is it to find what your looking for? 
• 20% to be Banner - That’s a personal identifier, to make your site unique and 

personalized. 
• 10% to be dead space: 
• Don’t overwhelm your visitor. Sites that make you want to go on a killing spree with its 

animation and dancing monkeys and crazy colors aren’t effective. 

3. Introduction to Dreamweaver 

Dreamweaver has a lot buttons and menus but we are only going to focus on the most 
frequently used ones. 

a.  Common Tab and Toolbar 

The icons will learn in this session are shown in the picture above surrounded by a box. 

The Common Tab (the first tab found at the top of the page) contains the most frequently 
used tools from each of the tabs.  Some of these include the hyperlink, table, image, 
and date tools. 

The toolbar includes a few more icons we will use which include the view you would like 
to use to edit your web site, the document title, file management options, and preview in 
the browser. 
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b. Design views 

Dreamweaver allows you to choose the view to edit you document in by choosing one 
of the following choices: 

• Code view (( ) - shows only the HTML code window 
• Code and Design view (( )) - shows both the HTML code window and the normal 

view or WYSIWYG (What you see is what you get) view. 
• Design view (( ) - shows only the normal or WYSIWYG view 

Above you see the Code and Design view. 

c. Properties Box 

The Properties box is located at the bottom of the window and it will contain different 
attributes that can be edited depending on the tool that you are using or editing. 
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The Properties box below is the for editing text. 

d. Site Files Area 

The Site Files Area allows you to setup a web site 
folder on your machine and it will contain all the 
files you need for your web site.  The files can be 
created directly in Dreamweaver and saved or 
you can save the files into the folder where your web 
site files are on your PC. 

When you begin you will not have any sites setup 
and you will need to define a site. 

3. Define a site 

• Select Define a Site from the Site Files Area 
Follow the Basic Wizard through each step to setup the site on your machine. 
• Give your site a name.  (Example: ITS, English, Handbook) 
• Click the NEXT buttom 
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Follow the next few screen shots to complete the setup of your site. 

Step 2: Server Technology 

Step 3: Where your files will be stored on your machine 
REMEMBER to click the NEXT button after each step. 

To change the location of your files, select the folder icon ( ) to the right of the box. 



Step 4: Setup FTP Connection 

Choose FTP (File Transfer Protocol) from the How do you connect to your remote server? 
drop-down box. 

Step 5: Enable Check In and Check Out 

Check in and Check out should be enabled when you have more than one person maintaining 
your site from multiple computers. 
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Final Step: Summary of the settings you chose in setting up your Site. 
Click the DONE button when you are ready to move on. 

4.  Copying the Template Files to your Local Site 

In the Site Files Area, select the Get Files icon ( ). 

Dreamweaver will prompt you to make sure you want to 
download the entire site.  Select OK. 

The only items that will be downloaded will be a styles 
folder containing the main style sheet (to standardize the 
fonts) called main.css and the collegesschool.dwt 
template file. 

You will need to create a folder called Images to help 
keep your files organized.  Go to the Site Files Area and 
select the File Menu - New Folder. 
Only put image files (.png, .gif, or .jpg) into this folder. 
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5.  Adding a New Page to Your Site 

Double-click on the file in the Site Files Area called collegesschools.dwt.  Save the tem-
plate file as a new file by going to the Dreamweaver File Menu - Save As... and give the file a 
name that corresponds to the content that will be on the page. 

REMEMBER: 
• Your homepage must be named either index.htm(l) or default.htm. 
• DO NOT use spaces or symbols and keep your filenames short. 

NOTE: The broken graphics in the template will be there when you are editing on your local 
machine, but once you upload the files to the server the graphics will appear. 

There are three editable regions in the template: 
• nameofdept/school (upper right box) 
• leftnavtable (left grey area - for navigation links) 
• bodytext (main text area and contact information to the right of the screen) 
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6. Editing the Template 

a. Name of Department or School 

• Edit the nameofdept/school region by 
just highlighting the text “Name of Dept/ 
School” and type in the name of your 
department or school. 

b. Navigation Table 

• Edit the leftnavtable region using your Site Map. 
• You will need to highlight the word “Link” and type in the 

words that best represent the link that will take them to 
the  content in your site. 

• Add more links into the navigation area 
– Highlight the dot ( )  that is located before the Link 
– Copy and paste it into the first cell on the row where 

you want to add a new link. 
– Once you copy the dot ( ) make sure to set the 

Horizontal Alignment to Center in the Cell Properties box 
(more information about tables is located on page 14) 

• Add a new link to the navigation area 
– Just place your cursor in the cell to the right of the dot ( ) and begin typing your 

text 

• Create a link in the navigation area to a page or other site 
– Highlight the text you want to make a link 
– In the Properties box, where it says Link (as on page 11) you can either: 

♦ Type the name of the page or URL into the box, 
♦ Select the Folder icon ( )) and select the file from your site files listed, or 
♦ Use the Target icon ( ) by left-clicking on the target and dragging the pointer 

to the file listed in the Site Files Area listing. 
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c. Body Text and Contact Information 

• You can add text to your web page by either typing the text directly into the template 
or by copying and pasting from another program. 

NOTE: If you copy and paste you text 
and the fonts do not look correct, make 
sure that you look at the CSS (Cascading 
Style Sheet) section  below to see how to 
apply the fonts to the new text. 

• To edit the Contact Information area in the bodytext 
region, just highlight and type in the correct information. 

• To add the Email Address, just follow the directions on 
page 11 of the documentation. 

7.  Using the Cascading Style Sheet (CSS) 

Make sure the you have the CSS window open by going to the Window menu and make sure 
their is a checkmark next to the CSS Styles window. 

The Cascading Style Sheet (.css file) defines the look of certain things in your web site by 
creating a class and in that class the font face, size, color, etc... are defined. 

The styles that are listed in your style sheet are to the right. 
• Navlinks - highlight you navigation links and select navlink 
• Title - For major headings within your content, type the 

heading, highlight the text and select title. 
• Programtitles or Subhead - For subheadings headings 

within your content, type the text, highlight the text and 
select programtitles or subhead 

• Text - Basic text is defined in this style.  If your copied text 
doesn’t look like the template text, highlight the paragraph 
and select text 

You just need to highlight the text that corresponds to the CSS 
style and then select the style name from the CSS Styles window. 



8.  Creating and Editing in Dreamweaver 

• Editing Text/Font Styles: Select the text you want to set font properties for and then 
use the Properties box in Dreamweaver to set the Format, Face, Size, Color, Decora 
tion, Alignment, Hyperlinks, Target, Lists, and Indentions. 

• Hyperlink: You can create a hyperlink to an external web page (outside of your own) 
or to an internal page (another page within your site). 

Highlight the text or picture that you want to be a hyperlink.  Select the Folder ( ) 
icon and choose the file you want to link to.  If you are creating a link to another web 
site, enter the URL into the URL box.  Or you can type the link into the Link box in the 
Properties box. 

• Email Link: Put your cursor where you want to enter the Email address link.  Select 
the Email Link icon ( ) and enter the text and email address.  If you only want the 
email address to show, you do not have to add content within the Text box. 

• Horizontal Rule: Use the Horizontal rule icon ( ) to add a line that is useful for 
organizing information. On a page, you can visually separate headings, text, and 
objects with one or more rules. 
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• Anchor: The Anchor icon ( ) will allow you to link to places in the same document or to 
specific places in other documents. 

Example: You have an index for your site with everything in your site listed in 
alphabetical order. You can place an Anchor where you want the link to go, such as 
where each section begins according to the letter in the alphabet or at the bottom of 
the page.  At the top of the page there would be a list of the letters in the alphabet, 
each linked to the area in the document that corresponds to that letter. 

• Insert Image: The Image icon ( ) will allow you to place pictures inside your page, 
while telling your computer where to locate the image file. If you just copy and paste the 
picture, it will not show up on the web because the page does not know where to go and 
get that picture. By inserting the picture you make sure that the picture will show up correctly. 

Once you place an image into your web page, make sure to go to the Properties box and 
add the ALT tag. 

ALT specifies alternative text that appears in place of the image for text-only browsers or 
for browsers that have been set to download images manually. For visually impaired 
users who use speech synthesizers with text-only browsers, the text is spoken out loud. 
In some browsers, this text also appears when the pointer is over the image. 
(Macromedia Dreamweaver Help Definition) 
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Image Properties Box: 

• Insert Date: The Date icon ( ) in Dreamweaver provides a convenient date object, 
which inserts the current date in whatever format you prefer (with or without the time) 
and provides the option of updating that date whenever you save the file.  This saves the 
date on which the page was last changed. 

• Insert Table: The Insert Table icon ( ) allows you to insert a table that can help you 
format the information on your web site better. 



Using Dreamweaver to Edit the Campus Template Page 14 

When the Table is selected you can use the Table Properties box to edit the number of 
rows and columns, width and height of  the table, cellpadding and cellspacing, alignment, 
border size, background color, border color and background image. 

Cellpadding is the space between the text in a cell and the edge of the cell. 
Cellspacing is the space between each cell. 

When the Cell is selected you can use the Cell Properties box to edit the horizontal and 
vertical alignment, width and height of the cell, and background information. 

Horizontal Alignment will align the text or graphics horizontally within a single cell. 
The options are Default, Left, Center, Right. 

Vertical Alignment will align the text or graphics vertically within a single cell. 
The options are Default, Top, Middle, Bottom, Baseline. 

• Save your Files: Select the File Menu and choose 
– Save (to save the specific file), 
– Save As... (to save the specific file under another name), or 
– Save All  (to save all the files that you have open in Dreamweaver - files with an 

asterisk (*) next to the name are changed but not saved). 

• Preview/Debug in Browser: Preview your files in a 
browser by selecting the Preview/Debug in Browser 
icon ( ). 
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9. Putting Web Site Files on the Server 

Use the File Management icon ( ) and select Put to transfer your files to the server.  You 
can also select the Put File(s) icon ( ) in the Sites area. 

Since we already setup the web site and the FTP information, you will only need to enter 
your password when you start to Put your files on the server. 

Go to a web browser (such as Internet Explorer or Mozilla) and view your web site online. 

10.  More Resources Available 

• For TTU web design policies look at the Public Affairs site 
Web Style Guidelines - 

http://www.tntech.edu/publicaffairs/web_publish/style_guide2.html 
Logos and Wordmark Usage - 

http://www.tntech.edu/publicaffairs/web_publish/logos.html 
http://www.tntech.edu/logos/logos.htm 

Colors - 
http://www.tntech.edu/publicaffairs/colors.html 

• Check out the Macromedia Help area 
• Contact the Institute for Technological Scholarship for more information and assistance. 

Location: TTU, Campus Box 5071, Room 215 
URL: http://www.tntech.edu/institute 
Phone Number: 931-372-3675 
Email Address: institute@tntech.edu 

• Look for more workshops offered by the Institute 

People to contact for further assistance with the template: 
Tamara Guzlas 
Web and Digital Media Director 
tguzlas@tntech.edu 
372-3619 

Lauren Neal 
Instructional Technology Specialist 
lneal@tntech.edu 
372-3675 

Created: October 28, 2004 


